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Please read this manual carefully before installing the system and carry out the installation 
procedures correctly. 
This manual provides guidelines for installation, but it does not guarantee the quality of the 
installation work. Please complete all work in a responsible and professional manner. Electrical 
work should be performed by a qualified electrician. 
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1. Introduction  

1.1 Scope of this documentation 
This documentation is written for trained electricians. Knowledge of national standards is 
required. The following document should be read before installing and operating the Radar PLC. 
If the following issues are disregarded, the equipment may get damaged and the safe function is 
not ensured. 
©This documentation is copyrighted by Continental Engineering Services GmbH (CES). Any 
reproduction, even parts, is only allowed with the permission of CES. 

1.2 Liability Conditions 

The responsible staff must ensure that all laws, standards, regulations and guidelines are 
fulfilled.  
All information is given in good faith; it does not represent a guarantee with respect to 
characteristics and does not exempt the user from testing the suitability of products and from 
ascertaining that the industrial property rights of third parties are not violated. No liability 
whatsoever will be accepted for damage – regardless of its nature and its legal basis – arising 
from advice given in this publication. This does not apply in the event that we or our legal 
representatives or management are found guilty of having acted with intent or gross negligence. 
No liability is borne for damage due to ordinary negligence. This exclusion of liability applies also 
to the personal liability of our legal representatives and employees and other persons employed 
in performing our obligations. All components are shipped in a condition to be able to fulfill the 
requirements in operation according to their scope. 
The Radar PLC must not be used in order to reduce safety systems, especially personal safety. 
The System should only be operated by personnel who are familiar with all states that can occur! 
Software knowledge is mandatory. The products are improved continuously. This may lead to 
differences in the description. 
We reserve the right to make technical modifications or to amend the delivery specifications. 
 
Please contact your supplier if it should become necessary to check the technical functions or to 
repair the device. 
 
 

1.3 Operating Personnel 

Every user of the CONTINENTAL® Radar PLC has to read this handbook and must be 
acquainted with all the functions of the system. 
Also every user has to read the documentation of the used continental Radar sensor.  
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1.4 Technical data 

 
 

Parameter Value 

Processor  Intel® Atom™ E3845, 1.91 GHz, 4 cores (TC3: 50) 

Flash memory  8 GB CFast card 

Internal main memory 4 GB DDR3 RAM 

Persistent memory integrated 1-second UPS (1 MB on Compact Flash card) 

Interfaces 

2 x RJ45, 10/100/1000 Mbit/s, DVI-I, 4 x USB 2.0, 1 x 

CANopen,2x4..20mA Analoge,8x Relay 

Diagnostics LED 1 x power, 1 x TC status, 1 x flash access, 2 x bus status 

Clock 

internal battery-backed clock for time and date (battery 

exchangeable) 

Operating system Microsoft Windows Embedded Standard 7 P 

Control software Continental Radar PLC Software 

Power supply 24 V DC (-15 %/+20 %) 

Dielectric strength 500 V (supply/internal electronics) 

Max. power  24 W 

USP Integrated 1s UPS (Up to 20s power with standard configuration) 

Dimensions (W x H x D) 185 mm x 100 mm x 92 mm 

Weight approx. 1,5 Kg 

Operating/storage 

temperature -25…+60 °C/-40…+85 °C 

Relative humidity 95 %, no condensation 

Vibration/shock 

resistance conforms to EN 60068-2-6/EN 60068-2-27 

EMC 

immunity/emission conforms to EN 61000-6-2/EN 61000-6-4 

Protection class IP 20 

Approvals CE 

Mount Cap rail 

Table 1: Technical data Continental Radar PLC 
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1.5 Product identification 
 
 
 
 

 
Figure 1 Radar PLC Hardware 
 
 
The Radar PLC is designed to display the output of either one Continental SRR208 or 
ARS308 Radar Sensor on a monitor. If collision detection is supported by the sensor, it is 
possible to use this device to trigger up to 8 different Solid state relays. 
The Radar PLC can be mounted on a cub rail.       
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2. Electrical Connection 
 
 
 

2.1 Connection to Power 
 
To bring the system into operation 24V DC has to be connected to the power input 
terminals. 
 

 
Figure 2  Power input terminals 
 
 
 

2.2 Connection to CAN 
 
The CAN interface allows the communication between a Notebook or PC and the device 
via a separate converter CAN to USB. The CAN bus must have a terminal resistance of 
respectively 120 Ω between CAN H and CAN L at the first and last subscriber to avoid 
reflections. The standard cable harness from Continental includes this resistor.   
The CAN BUS of the Radar Sensor has to be connected to the CANopen connector 
plug. 
 

 
Figure 3 CANopen connector plug  
 
 

2.3 Connection to relative Speed and yaw rate signa l  
When the radar is integrated in a vehicle, the radar sensor needs the vehicle speed. This 
can be done by an input current (4...20mA) from outside. 
 



 
 Continental Engineering Services GmbH 

Version : 2.01 en 
  Page 8 of 40 

 
 
Figure 4 Analog input terminal 
 
The speed signal has to be connected to terminal 1 and 2. 
The run LEDs give an indication of the data exchange with the Bus Coupler. The error 
LEDs indicate an overload condition, also it shows a cable break (0mA). 
Also it is possible to connect a yaw-rate to terminal 5 and 6 
 
 
 

Parameter Value 

Technology differential input 

Signal current  4…20 mA 

Internal resistance 50 Ω typ. shunt, load: 60 Ω + diode voltage 

Common-mode voltage 

UCM 35 V max. 

Table 2: Technical data analog input terminal 
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2.4 Connection to Output Relays 
 
The Radar PLCs is able to support up to 8 solid state relays, when a collision is 
detected1. With these Relays costumer specific functions can be triggered.  
 
 

 
Figure 5 Relays output terminal 
 
The digital Terminal provides eight switches that can be used like a relay contact for 
AC/DC voltages. The electronic switch is realized through high-performance MOSFET 
transistors with a low switch-on resistance. The switch itself is not short-circuit-proofed, 
but due to its high pulse current capability it can cope with currents until an external fuse 
triggers a switch-off. Wear resistance increases the availability of the application. 
Resistive and light inductive loads can be switched up to a rated voltage of 30 V AC/DC, 
completely resistive loads also up to a rated voltage of 48 V DC. High peak voltages and 
electromagnetic interference pulses are prevented. 
 

                                                           
1 Only possible, if the radar sensor supports collision detection. (SRR 208-21 / -2C or ARS 308-21 / -2C) 
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Parameter Value 

Rated load voltage 0…30 V AC/DC (only ohmic load: 0…48 V DC) 

Short circuit current  not short-circuit-proof, see peak current 

Output current 2 A (∑ 10 A @ 55° C) 

Breakdown voltage 80 V 

Peak current 5 A (100 ms), < 50 A (10 ms) 

Conductor connection 

solid wire conductors: direct plug-in technique; stranded wire 

conductors and ferrules: spring actuation by screwdriver 

Rated cross-section 

solid wire: 0.08…1.5 mm²; stranded wire: 0.25…1.5 mm²; ferrule: 

0.14…0.75 mm² 

  

Table 3: Technical data output relays 
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3. Software 
 
The Radar PLC software starts automatic when powering up the embedded PC. It takes 
about 2 minutes. 
 
 

 
Figure 6 Radar PLC Software 
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3.1 Overview 
 
The software consists of two parts: 
 

 
Figure 7 Two parts of the Radar PLC Software  
 
 
 
 
 
 
3.1.1  Real-time I/O software  
 
This software part is responsible for the communication between the In- and Output-
Cannels and the Visualization software.  It is operating between the hardware and the 
Windows operating system. This allows the software to work around the Windows 
system instantly providing exceedingly fast access times for hardware communication.  
 
 
3.1.2  Visualization Software  
 
This software represents the Graphical User Interface (GUI) for the Radar Sensor 
signals. This GUI operates on the Windows System and communicates with the real-time 
I/O software. It shows objects the Radar detected and enables the user to configure the 
Radar Sensor.  
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4. GUI 
 
The handling of the SRR- and ARS-Sensor is different. So the user has to configure the 
software according to the connected sensor. 
 

 
Figure 8 Configuration of Sensor type 
 
The Continental Radar PLC menus and appearance is adjusted on startup according to 
the Sensor (SRR20X, ARS30x) referenced in the “program.ini” file in the Continental 
Radar PLC folder. By editing the “program.ini” the default startup sensor can be 
configured. To do so, edit the “defaultSensor” parameter in “C:\Continental Radar-
PLC\program.ini”. Valid values for that parameter are “ARS30x” and “SRR20X”. 
 

4.1   SRR Sensor 
 

 

Figure 9 SRR Main Screen 
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The main screen shows the SRRs field of view, marked by the turquoise area. The white 
triangles mark everything outside the sensors detection scope. By the sensor detected 
entities are displayed as small red boxes within the field of view of the sensor. The 
markers also provide additional information about detected entities. Besides the entities 
location further information about its speed and the Radar Cross Section (RCS) is 
displayed. An exemplary marker is shown as information in the lower right corner of the 
Main Screen.  
The sensors supports two modes. It can display the Sensors signals either as Tracks or 
Cluster2.  
 
 

4.1.1 Cluster 
 
The Cluster display can be activated by selecting Cluster from the Mode Menu. 
 

 
Figure 10 Mode selection for Cluster  
 
Clusters represent reflected signals with similar position and movement. The software is 
able to display up to 128 Cluster at once. Each Cluster provides a set of information. 
  

 
Figure 11 SRR Cluster Markings  
 

Parameter Description 

Index Current index of the cluster in the cluster list 

RCS Radar Cross Section[dB*m^2] 

Range Radial distance of the cluster[m] 

Azimuth Cluster angle[°] 

Vrel Relative velocity of the cluster[m/s] 

Table 4 Cluster parameter overview  
 
The displayed set of information can be altered between displaying the RCS value 
(Figure 11a) or the relative velocity (Figure 11b) by configuring the view available in the 
View-Menu. 
 
 

                                                           
2 See the SRR208 manual for description 
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Figure 12 View Settings for Cluster  
 
4.1.2 Tracks 
 
The Track mode can be activated by selecting Tracks from the Mode Menu. 
 
 

 

Figure 13 Mode selection for Tracks 
 
 
Tracks in contrast to Cluster have a history. They represent Cluster tracked over time. 
The software is able to display up to 25 Tracks at once. Each Track provides a set of 
information. 
 
 

 

Figure 14 SRR Track Markings  
 
 

Parameter Description 

Index Current index of the track in the track list 

Track ID Unique ID identifying the track 

RCS Radar Cross Section[dB*m^2] 

vx Relative longitudinal velocity[m/s] 

vy Relative lateral velocity[m/s] 

Table 5 Track parameter overview 
 
The displayed set of information can be altered between displaying the TrackID and RCS 
value (Figure 14a) or the relative longitudinal and lateral velocities (Figure 14b) by 
configuring the view available in the View-Menu. 
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+  

Figure 15 View Settings for Tracks 
 
 

4.1.3 Sensor Configuration Window 
 
Basic Sensor properties can be adjusted in the “Sensor Configuration ” window. To 
open it, select Options/ Sensor Configuration.  
 

 

Figure 16: The Sensor Configuration Window 

4.1.3.1. CAN-Bus Log 

In the “Sensor Configuration ” window you can activate a CAN-Log which will record 
every CAN-Message sent by the sensor.  
The logging file “CAN_DATA.asc” is stored at the location shown at “Logging Path”. This 
is the default Logfile location . If you want to adjust the Logging Path, you can do so by 
changing the “logPath” parameter in the “program.ini” file in the program folder 
“C:\Continental Radar-PLC\program.ini”. 
 
Note:  When changing the default Logfile location, it is mandatory  to enter a valid path-
string  e.g. c:\data\CAN_DATA.asc without any apostrophes or quotation marks. In 
general it might be helpful to create backup copies of all *.ini files before changing 
parameter values. 
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4.1.3.2. Sensor ID Configuration 

The Sensor ID Configuration  allows selecting a sensor ID for the connected sensor. 
The Sensor ID also determines the address space of CAN communication messages 
according to (base message ID | (0x10 * sensor ID)). 
 
The Current Sensor ID  option shows the currently used Sensor ID. The Set Sensor ID  
option allows changing the Sensor ID. Therefore a value between 0 and 7 can be 
selected from the drop-down menu. Confirming the new value by pressing the Set-
Button  will write the new configuration to the Radar-Sensor.  
 
 

4.1.4 Filter 
 
To see only application relevant Cluster or Tracks it is possible to set filter values. This 
allows the software to reject entities that violate the set of rules established by the filter 
values thus displaying only relevant Cluster or Tracks. 
 
 

 

Figure 17 Enable Filter 
 
 
The filter can be adjusted and activated in the Filter Settings, available through the 
Options/Edit Filter Menu. Since Tracks and Cluster data come with different sets of 
parameters the Filter Menu automatically adjusts to the respective display mode. Figure 
18 and Figure 19 display the Filter Settings for Cluster and Tracks. 
 
Customized filter values can be written to an Ini-File  for later use by pressing the “Save 
to Ini” Button. Depending on whether Cluster or Tracks are selected, the filter values will 
be written to the “C:\Continental Radar-PLC\SRR20X.ini” File at the Key “filter_tracks” for 
Track-Mode or “filter_cluster” when the display mode is set to Cluster. Formerly saved 
customized filter values can be loaded from the Ini by pressing the “Load from Ini” 
Button. 
 
Note:  The Ini-Filter values will be loaded automatically after program startup and when 
switching the Sensor-Type or Send Mode. This includes the filter activation. 
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Figure 18 Cluster Filter Settings 
 
 
 

Parameter Description 

Activate Filter Flag the filter to be activated on confirmation 

Maximum Cluster Index Maximum Cluster Index to be displayed 

RCS-Value Radar Cross Section range to be displayed 

Range Distance range in which Cluster should be displayed 

Azimuth-Angle Angle range in which Cluster should be displayed 

Relative Velocity Relative Velocity range for Cluster that should be displayed 

Table 6 Cluster Filter value description 
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Figure 19 Track Filter Settings 
 
 
 
 

Parameter Description 

Activate Filter Flag the filter to be activated on confirmation 

Maximum Track Index Maximum Track Index to be displayed 

RCS-Value Radar Cross Section range to be displayed 

Longitudinal 

Displacement 

Displacement range in longitudinal direction in which Tracks should be 

displayed 

Lateral Displacement 
Displacement range in lateral direction in which Tracks should be 

displayed 

Relative Velocity 

(Longitudinal) 

Relative velocity range in longitudinal direction  for Tracks that should 

be displayed 

Relative Velocity 

(Lateral) 

Relative velocity range in lateral direction for Tracks that should be 

displayed 

Table 7 Track Filter value description 
 
 
In the Filter Settings the signals can be filtered by all relevant information. Only 
Cluster/Tracks within the activated filter range will be displayed on screen. For the filter 
to take effect it needs to be activated and applied. Upon start and when no customized 
filter values have been saved to the Ini file, the filter value range for each parameter 
reflects the sensors default value range. Edited filter values can easily be restored to the 
original sensor default value range by pressing the “Default Filter Values” Button. 
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4.1.5 Collision Detection 
 
Collision Detections is only supported with a SRR 208 with sensor internal collision 
detection software (optional). 
The Collision Detection recognition is done directly on the sensor itself and the 
visualization software only reflects the current collision states monitored by the Radar. 
So the filter function is not supported.  At present the Collision Detection for the sensor 
versions mentioned above is only available for Tracks.  
 
The collision detection Configuration is accessible through the Options/Collision 
Detection Menu. 
 
  

 

Figure 20 SRR Collision Detection Configuration 
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Parameter Description 

General Settings 

Activate Collision Detection Region independent. De-/activate collision detection function 

Set Object Detection Time 

Minimum time an objects needs to be detected before warning 

is triggered 

Region Settings 

0…7 Number of the region  

Set Coordinates Activates selected region for drawing 

Activate Region Activates selected region for collision detection 

X X value of the upper left corner of the warning region 

Y Y value of the upper left corner of the warning region 

W Width of the warning region 

H Height of the warning region 

Table 8 SRR Collision Detection Settings 
 
 
In Collision Detection Mode the user is able to define and activate up to 8 Warning 
Regions for which he will receive collision detection information.  
 
The Collision Detection Configuration is separated into General Settings which affect the 
Collision Detection function as a whole and Region dependent settings which only affect 
the selected Warning Region. To bring the Collision Detection to work the user first 
needs to activate the Collision Detection Functionality on the sensor. Furthermore at 
least one Warning Region needs to be defined  and activated . Only then the Sensor will 
monitor the defined region for collision detection violations. 
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Figure 21: SRR defining warn regions 
 
 
 
To define a Warning Region the Set Coordinates Flag of the respective region needs to 
be set. This activates the selected region for drawing. By left-clicking into the Main 
Screen and dragging the mouse a rectangular, Warn Regions can be created. While 
moving the mouse the regions X, Y, W and H Parameters in the Collision Configuration 
Window will be updated.  
When selecting a Region for drawing, some crossed out areas can be seen. Those limit 
the Sensors detection scope and make sure only valid regions are defined. When trying 
to set invalid values to warning regions by starting or ending outside the detection scope 
the region will automatically use the maximum valid value for the respective invalid 
coordinate (Figure 21). 
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Figure 22 SRR Collision Detection Mode 
 
 
To activate the region the “Activate Region” flag needs to be set. The Send Config 
Button will write the General Settings and the Region Settings of active Regions to the 
Radar Sensor.  
 
The Regions current color also reflects the regions current state (grey = inactive, green = 
activated, red = warning). 
 
A defined Region-Setup can be stored by pressing the “Save to Ini” Button. Hereby all 
region coordinates and their active state as well as the general Collision Detection 
settings are written to the “C:\Continental Radar-PLC\SRR20X.ini” at the key 
“coll_det_regions”. Respectively a saved Region-Setup can be loaded by pressing the 
“Load from Ini” Button.  
 
By selecting the “Reset all Warnings” Button, all active Warning Regions on the Sensor 
will be reset to the “No Warning State” (green) until another violation of the region is 
detected. This can be immediately if no restrictions are set or after the Minimal Detection 
Time if it is selected and written to the sensor. 
 
The “Delete all Regions” Button deletes all Regions that are currently observed by the 
Radar Sensor. No Collision Detection Warnings will be sent after this, unless a new 
region is created. 
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By selecting the “Stop C (ollision)D(etection)” Button the Collision Detection Functionality 
is shut down. No more Collision Detection Warning Messages are sent until the 
Functionality gets reinitialized. 
 
In Collision Detection Mode the Radar Sensor is unable to send regular Track Signals 
displayed in None Collision Detection Mode, however creating a warning region that 
covers the whole Main Screen will allow the sensor to detect all Tracks within his 
detection scope.  But note that the displayed tracks are Warning Tracks, meaning Tracks 
that triggered a Collision Detection Warning, thus the region activation is mandatory. 
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4.2 ARS 308 Sensor 
 

 

Figure 23 ARS308 Main Screen in Near-View 
 
 
The Main Screen shows the ARS308s field of view. The Yellow and turquoise areas 
indicate the sensors Near- and Long-Range detection areas. Since the Long-Range area 
covers a distance up to 200m it is possible to switch the view area from Near-View 
(standard, Figure 23) to Far-View (Figure 25). This option can be activated by selecting 
Far-View from the View Menu. 
 
 

 

Figure 24: Far-View selection for the ARS308 Sensor . 
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Figure 25: ARS308 Main Screen in Far-View  
 
 
 
The white areas are outside the sensors detection scope. By the sensor detected entities 
are displayed as small red boxes within the field of view of the sensor. The markers also 
provide additional information about detected entities. Besides the entities location 
further information about its speed, dimensions and the Radar Cross Section (RCS) are 
displayed. An exemplary marker is shown as information in the lower right corner of the 
Main Screen. The sensor supports two modes. It can display the Sensors signals either 
as Objects or Targets3.  
 
 
 
 
 
 

                                                           
3 See the ARS308 manual for description 
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4.2.1 Targets 
 
The Targets display can be activated by selecting Targets from the Mode Menu.  
 

 

Figure 26 Mode Selection for Targets  
 
 
Targets represent reflected signals with similar position and movement. The software is 
able to display up to 96 Targets at once. Each Target provides a set of information. 
 
  

 

Figure 27 ARS308 Target Markings 
 
 
 

Parameter Description 

NoOfTarget Target number in the Target List 

RCS  Radar Cross Section[dB*m^2] 

Range Target Range 

Angle Target Angle[°] 

Vrel Target relative velocity[m/s] 

Table 9 Target parameter Overview 
 
 
The displayed set of information can be altered between displaying the RCS value 
(Figure 27a) or the relative velocity (Figure 27b) by configuring the view available in the  
View Menu. 
 
 

 

Figure 28 View settings for Targets  
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4.2.2 Objects 
 
The Objects display can be activated by selecting Objects from the Mode Menu.  
 

 

Figure 29 Configuration - Targets / Objects  
 
 
Objects in contrast to Targets have a history. They represent Targets tracked over time. 
The software is able to display up to 40 Objects at once. Each Object provides a set of 
information. 
 
 

 

Figure 30 ARS308 Object Markings 
 
 

Parameter Description 

ObjectID Unique Object ID 

Length Object Length[m] 

Width Object width[m] 

RCS  Radar Cross Section[dB*m^2] 

VrelLong Relative longitudinal speed[m/s] 

Vlat Object lateral velocity[m/s] 

Table 10 Object parameter overview 
 
 
The displayed set of information can be altered between displaying the RCS value 
(Figure 30) and the relative longitudinal and lateral velocities (Figure 31) by configuring 
the view available in the View Menu. 
 
 

 
Figure 31 View Settings for Objects  
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4.2.3 Sensor Configuration Window 
 
Basic Sensor properties can be adjusted in the “Sensor Configuration” Window. To 
open it, select Options/ Sensor Configuration  
 

 

Figure 32: ARS 308 Sensor Configuration Window  
 
 

4.2.3.1. CAN-Bus Log 

In the “Sensor Configuration ” window you can activate a CAN-Log which will record 
every CAN-Message sent by the sensor.  
The logging file “CAN_DATA.asc” is stored at the location shown at “Logging Path”. This 
is the default Logfile location . If you want to adjust the Logging Path, you can do so by 
changing the “logPath” parameter in the “program.ini” file in the program folder 
“C:\Continental Radar-PLC\program.ini”. 
 
Note:  When changing the default Logfile location, it is mandatory  to enter a valid path-
string  e.g. c:\data\CAN_DATA.asc without any apostrophes or quotation marks. In 
general it might be helpful to create backup copies of all *.ini files before changing 
parameter values. 
 

4.2.3.2. Sensor ID Configuration 

The Sensor ID Configuration  allows changing the ID between 0 and 7 for the 
connected sensor. The Sensor ID also determines the address space of CAN 
communication messages according to (base message ID | (0x10 * sensor ID)). 
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The Current Sensor ID  option shows the currently used Sensor ID. The Set Sensor ID  
option allows changing the Sensor ID. Therefore a value between 0 and 7 can be 
selected from the drop-down menu. Confirming the new value by pressing the Set-
Button  will write the new configuration to the Radar-Sensor.  
 

4.2.3.3. Detection Value Configuration 

The Detection Value Configuration  allows adjusting the Radar sensors detection scope 
by changing the plate  elevation  and the Range Length . By adjusting the sensor’s plate, 
the elevation angle of the radar beam is altered between 0° (inclined towards the sky) 
and 32° (inclined towards the ground). By setting the range length parameter, the 
maximum distance at which objects will be detected can be adjusted between 50m and 
200m. By adjusting both parameters the radar sensor can be optimized to receive 
optimal reflections from an area of interest. With a shorter range, the measurement 
accuracy of the measured distances are getting better. 
 
 

4.2.3.4. Update Input Values 

These values are used, when the sensor is mounted on vehicle. It helps to separate 
moving objects from the environment. 
By selecting Update Input Values  the currently vehicle speed  and yaw rate  are 
displayed and continuously updated. Those signals are calculated from the externally set 
input current (4…20mA) on the EL3122 module (2.3, p.7). The default minimum and 
maximum values for speed and yaw rate are set to the sensors limits. Both values can 
be adjusted by entering new values in the “Min.” and “Max.” fields and activated by 
pressing the Set Button. 
 
 
It is also possible to save Detection Value Configuration  and the set minimum and 
maximum values of the Input Values Configuration  to the “ARS30x.ini” file. 
Respectively a saved Detection Value Configuration and Input Value Configuration can 
be loaded by pressing the “Load from Ini” Button. 
 
The “Default Values” Button resets the Set Sensor ID  within the Sensor ID 
Configuration  the whole Detection Values Configuration  and the minimum  and 
maximum  values for speed and yaw rate within the Input Values Configuration  to their 
individual default value given by the radar sensor. 
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4.2.4 Filter 
 
To see only application relevant Targets or Objects it is possible to set filter values.  

 

Figure 33 Enable Filter 
 
The filter can be adjusted and activated in the Filter Settings, available through the 
Options/Edit Filter Menu. Since Objects and Targets data come with different sets of 
parameters the Filter Menu automatically adjusts to the respective display mode. Figure 
34 and Figure 35 display the Filter Settings for Objects and Targets. 
 
Customized filter values can be written to an Ini-File  for later use by pressing the “Save 
to Ini” Button. Depending on whether Objects or Targets are selected, the filter values 
will be written to the “C:\Continental Radar-PLC\ARS30x.ini” File at the Key 
“filter_objects” for Object-Mode or “filter_Targets” when the display mode is set to 
Targets. Formerly saved customized filter values can be loaded from the Ini by pressing 
the “Load from Ini” Button. 
 
Note:  The Ini-Filter values will be loaded automatically after program startup and when 
switching the Sensor-Type or Mode.  
 
 

 

Figure 34 Target Filter Settings 
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Parameter Description 

Activate Filter Flag the filter to be activated on confirmation 

Maximum Target Index Near Maximum Index of Targets in Near distance to be displayed 

Maximum Target Index Far Maximum Index of Targets in Far distance to be displayed 

Relative Velocity Relative velocity range for Targets that should be displayed 

Distance Distance range in which Targets should be displayed 

Angle Angle range in which Cluster should be displayed 

RCS-Value Radar Cross Section range to be displayed 

Table 11 Target Filter value description 
 

 

Figure 35 Object Filter Settings 
 
 

Parameter Description 

Activate Filter Flag the filter to be activated on confirmation 

Maximum Object Index Maximum Object Index to be displayed 

Longitudinal 

Displacement 

Displacement range in longitudinal direction in which Objects should 

be displayed 

Lateral Displacement 
Displacement range in lateral direction in which Objects should be 

displayed 

RCS-Value Radar Cross Section range to be displayed 

Relative Velocity 

(Longitudinal) 

Relative velocity range in longitudinal direction  for Objects that 

should be displayed 

Relative Velocity Relative velocity range in lateral direction for Objects that should be 
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(Lateral) displayed 

Object Length Length range for Objects that should be displayed 

Object Width Width range for Objects that should be displayed 

Table 12 Object Filter Value description 
 
In the Filter Settings the signals can be filtered by all relevant information. Only 
Targets/Objects within the activated filter range will be displayed on screen. For the filter 
to take effect it needs to be activated and applied. Upon start and when no customized 
filter values have been saved to the Ini file, the filter value range for each parameter 
reflects the sensors default value range. Edited filter values can easily be restored to the 
original sensor default value range by resetting the filter values. Edited filter values can 
easily be restored to the original sensor default value range by pressing the “Default 
Filter Values” Button. 
 
4.2.5 Collision Detection 
 
If the ARS308 Radar Sensor supports collision detection, this function can be activated. 
This is done directly by the sensor itself and the visualization software only reflects the 
current collision states monitored by the Radar Sensor. So the filter function is not 
supported. Collision Detection is only available for Objects. 
 
The collision detection Configuration is accessible through the Options/Collision 
Detection Menu. 
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Figure 36 ARS308 Collision Detection Configuration 
 
 
 

Parameter Description 

General Settings 

Activate Collision Detection Region independent. De-/activate collision detection function 

Set Object Detection Time 

Minimum time an objects needs to be detected before warning 

is triggered 

Minimum Object Width 

Minimum Width an object needs to have in order to trigger a 

warning. 

Region Settings 

0…7 Number of the region  

Set Coordinates Activates selected region for drawing 

Activate Region Activates selected region for collision detection 
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X X value of the upper left corner of the warning region 

Y Y value of the upper left corner of the warning region 

W Width of the warning region 

H Height of the warning region 

Table 13 ARS Collision Detection Settings 
 
In Collision Detection mode the user is able to define and activate up to 8 warning 
regions for which he will receive collision detection information. Each warning region is 
connected to an output relay (See 2.4) 
 
The Collision Detection Configuration is separated into General Settings which affect the 
Collision Detection function as a whole and Region dependent settings which only affect 
the selected Warning region. For starting the Collision Detection, the user first needs to 
activate the Collision Detection Functionality on the sensor. Furthermore at least one 
Warning Region needs to be defined  and activated . Only then the Sensor will monitor 
the defined region for collision detection violations. 
 
 

 

Figure 37: ARS 308 defining warn regions  
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To define a Warning Region the Set Coordinates Flag of the respective region needs to 
be set. This activates the selected region for drawing. By left-clicking into the Main 
Screen and dragging the mouse a rectangular Warn Region can be created. While 
moving the mouse the regions X, Y, W and H Parameters in the Collision Configuration 
Window will be updated. 
When selecting a Region for drawing, a crossed out area can be seen. It limits the 
Sensors detection scope and makes sure only valid regions are defined. When trying to 
set invalid values to warning regions by starting or ending outside the detection scope 
the region will automatically use the maximum valid value for the respective invalid 
coordinate (Figure 37). 
 
 
 
 

 
Figure 38: ARS-Collision Detection Mode 
 
To activate the region the Activate Region flag needs to be set. The “Send Config ” 
Button will write the General Settings and the Region Settings of the currently selected 
Region to the Radar Sensor. 
 
The Regions current color also reflects the regions current state (grey = inactive, green = 
activated, red = warning). 
 
A defined Region-Setup can be stored by pressing the “Save to Ini” Button. Hereby all 
region coordinates and their active state as well as the general collision settings are 
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written to the “C:\Continental Radar-PLC\ARS30x.ini” at the key “coll_det_regions”. 
Respectively a saved Region-Setup can be loaded by pressing the “Load from Ini” 
Button.  
 
By pressing the “Reset all Warnings” Button, all active warning regions on the Sensor 
will be reset to the “No Warning State” (green). 
  
The “Delete all Regions” Button deletes all Regions that are currently observed by the 
Radar Sensor. No Collision Detection Warnings  will be sent after this. 
 
By selecting the Stop C (ollision) D(etection) Button  the Collision Detection Functionality 
is shut down. No more Collision Detection Warning Messages  are sent until the 
Functionality gets reinitialized. 
 
In Collision Detection Mode the Radar Sensor is unable to send the regular Object 
Signals displayed in None Collision Detection Mode, however creating a Warning Region 
that covers the whole Main Screen will allow the sensor to detect all Objects within his 
detection scope.  But note that the displayed Objects are Warning Objects, meaning 
Objects that triggered a Collision Detection Warning, thus the region activation is 
mandatory.  
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5. Tools 
 

5.1 Remote Desktop 
 
When the Radar PLC is connected over an Ethernet cable to another computer it is 
possible to access the Radar PLC over Remote Desktop.   
 
IP. Address: 
 
169.254.167.240 
 
Password: 
Arcus  
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6. Appendix 
 

6.1 Power Supply AC/DC 
 
For the Power supply with 100-240 VC AC it is possible to use the PULS ML 30.106 
power supply. It delivers 24V DC for the Radar PLC and 12V for the Radar Sensor 
 

 
Figure 39 PULS ML 30.106 power supply 
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6.2 Power Supply DC/DC 
 
    RS 50W Single Output 12V DC/DC voltage converter – Output 24V DC 
 

 
Figure 40 12/24V DC/DC voltage converter 
     (part of delivery) 


